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Exam A

QUESTION 1
As part of their brand guidelines, Northern Trail Outfitters (NTO) uses a custom brand font for all print marketing materials. NTO wants to use their custom brand font in email as well.
What is the recommended best practice for font usage in email?

A. Use a web-safe font for text that closely matches the brand's custom font.

B. Build an email as one image, with all text saved in the brand font.

C. Edit an email's HTML to list the custom brand font in the style tag's font-family property.

D. Build an email using multiple images, with all text saved in the brand font.

Correct Answer: A
Section:

QUESTION 2
A retail company's database of record resides at a 3rd-party company that also keeps track of purchase history.
That database only updates once a day where new records can be created and merged.
The database uses an "Email ID," which is a numeric field that represents both the business unit and email address.
The company now wants to be able to send real-time Welcome emails to people (newly registered website users) who provide their email address in exchange for getting 10% off their first order, and ensure this send is
connected to "Email ID" in the database.
What key issue should be addressed?
Choose 3 answers

A. How will Marketing Cloud and the database sync up?

B. Will new users have an "Email ID"?

C. What will be used as Subscriber Key?

D. What publication lists will be used?

E. Will the company need a custom preference center?

Correct Answer: A, B, C
Section:

QUESTION 3
Northern Trail Outfitters is noticing a gradual decline in the percentage of conversions per emails sent in their digital marketing campaign. A new initiative is being adopted to reverse the trend What action should be taken to
increase subscriber engagement?
Choose 2 answers

A. Increase volume of emails to a wider audience.

B. Increase the use of dynamic content in emails.

C. Adopt a Cart Abandonment Email Campaign.

D. Introduce more identity verification steps in check out process.

Correct Answer: B, C
Section:
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QUESTION 4
A retail company does business in both the United States and Canad a. They also have a loyalty program in which a customer can enroll. The company will provide a presegmented customer file, per campaign, which has a
"Version" data field indicating the type of email the customer is to receive.
What question should be asked to determine a data/segmentation strategy?
Choose 2 answers

A. Will customers be able to sign up for the loyalty program at the store?

B. Is the purpose of these emails for acquisition or retention or transactional?

C. Will multiple languages be used, with a "From Name" lookup table needed?

D. Will version values/meanings change, precluding reusable AMPscript?

Correct Answer: C, D
Section:

QUESTION 5
A customer is interested in designing a solution to ensure that subscribers only receive categories of emails that they want to receive. The built-in subscription center will be used as part of the solution.
Which feature should be utilised to make this happen?

A. Publication Lists

B. Subscriber Keys

C. Profile Center

D. Send Logging

Correct Answer: A
Section:

QUESTION 6
A financial services customer states that families often share email addresses across multiple checking, savings, loan, and credit accounts. The customer needs to allow individual accounts to use the same email address in
Marketing Cloud but maintain separate subscriber attributes.
Which component should be discussed with the customer to allow for this use case?

A. Subscriber Key

B. Contact ID

C. Member Record

D. Data Extensions

Correct Answer: A
Section:

QUESTION 7
A customer team wants to retarget subscribers who click on links of key items promoted across email campaigns. The customer has indicated the following:
* Emails will be built using a custom dynamic template for these messages.
* Links will vary over time and across campaigns.
* Click activity will be cross-referenced with subscribers' regional markets on a master subscriber data extension.
* Retargeting messages will dynamically populate content based on regional market.
In order for this solution to be viable, which skill set does the customer team need to possess?

A. AMPscript
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B. SSJS

C. SQL

D. HTML

Correct Answer: A
Section:

QUESTION 8
During discovery, the customer outlines data requirements and the anticipated use of Marketing Cloud with the following criteria:
* Customer data will be fully refreshed every night via Import activity from the customer's data warehouse.
* Contact records will be augmented by relational data tables via Contact Builder.
* The customer data file will contain 5M records with 40+ attributes.
* One attribute will house HTML code, 1000 characters max, that will be used to populate Account Access content areas in emails.
* A customer ID will be used as the unique identifier for each contact.
Which statement differentiates the use of data extensions over lists?

A. Data extensions allow for add/update Import activity.

B. Data extensions can store HTML code as an attribute.

C. Data extensions support Customer ID to be used as Subscriber Key.

D. Data extensions are necessary for Contact Builder

Correct Answer: D
Section:

QUESTION 9
A publishing company has presented the following:
* A need to send renewal reminders to customers whose subscriptions expire in 15 days and 7 days.
* A campaign needs to be created and managed by a general marketing user who will not have administrative rights and who is not technical.
* The customer's expiration date is included in the data file.
What component should the customer's solution include?
Choose 3 answers

A. Suppression list

B. Data Filter

C. Triggered Send

D. Template-based emails

E. Automation Studio

Correct Answer: B, D, E
Section:

QUESTION 10
Analyst of The Northern Trail Outfitters (NTO) marketing team needs to pull email metrics for an upcoming quarterly company meeting. These metrics need to be reported per email campaign for each of NTO's Business Units:
* Number of Sends
* Delivery Rate
* Overall Bounce Rate
* Block Bounce Rate
* Open Rate
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* Click Rate
* Complaint Rate
* Unsubscribe Rate
Which email report should NTO's Marketing Analyst pull from Marketing Cloud to get this information?

A. Campaign Email Tracking Report

B. Email Performance Over Time Report

C. Email Send Report

D. Account Send Summary Report

Correct Answer: A
Section:

QUESTION 11
Northern Trail Outfitters (NTO) wants to better understand subscriber behavior on their website upon arrival via an email message. A local member of a Marketing Cloud user group mentioned the Web Analytics Connector.
Which benefit is offered by installing the Web Analytics Connector in a Marketing Cloud account?
Choose 3 answers

A. Use the web analytics platform to trigger behavioral remarketing emails.

B. Track web activity from a click on an email URL back to a specific email campaign.

C. Pass web conversion data back into Marketing Cloud for use in email reporting.

D. Recognize web traffic as originating from email instead of another channel.

E. Match subscribers to web activity by passing Subscriber ID through email links.

Correct Answer: B, D, E
Section:

QUESTION 12
A customer wants to integrate their website with Marketing Cloud so that users can update their marketing communication preferences. The customer has in-house web development resources available and is interested in
leveraging tools such as Journey Builder in the future.
What solution should the consultant propose, given the customer's requirements and available resources?

A. Configure a relational data structure using Data Extensions and consult with the customer on API integration with their website.

B. Configure a data structure using Lists and leverage a SmartCapture form that the client can iFrame into their website.

C. Configure a relational data structure using Data Extensions and leverage a SmartCapture form that is hosted in Landing Pages.

D. Configure a data structure using Lists and leverage the out-of-the-box Preference Center.

Correct Answer: A
Section:

QUESTION 13
Northern Trail Outfitters (NTO) wants its monthly distributor newsletter email to appear to be sent on behalf of the subscriber's account representative without segmenting the audience by sales representative.
How should this distributor-specific sender profile be configured in the Marketing Cloud?
Choose 2 answers

A. Pick "Choose from list," selecting the from name and from email values from the list of account users.

B. Utilize data extension AMPScript lookups to dynamically populate the from name and from email values.
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C. Match the external keys of the sender profile and data extension containing account representative details.

D. Populate substitution strings in the sender profile for the profile attributes containing from name and from email values.

Correct Answer: B, D
Section:

QUESTION 14
A large retail company has selected Marketing Cloud and has asked to be fully migrated from their existing platform in three weeks. They have communicated the following:
* They currently have 3 million customers.
* They email customers twice a week with no known deliverability issues.
* Their contract includes one Sender Authentication Package (SAP).
What response articulates proper IP warming?
Choose 2 answers

A. IP ramp-up takes four to six weeks to be able to fully send to all 3 million customers.

B. IP ramp-up can be accelerated by migrating to pre-warmed IP addresses.

C. IP ramp-up is important to establish a positive sender reputation.

D. IP ramp-up can be bypassed, given their historical lack of deliverability issues.

Correct Answer: A, C
Section:

QUESTION 15
A consultant is configuring Marketing Cloud Connect in Marketing Cloud. The customer requires that integrated users only have access to Sales Cloud data visible to them in their Salesforce account.
How would the consultant ensure that this requirement is met?

A. Check the Scope by User box in Marketing Cloud.

B. Create a User in Sales Cloud with a System Administrator Profile.

C. Ensure that the User has the correct profile in Marketing Cloud.

D. Ensure that the User is assigned as System Administrator in Sales Cloud.

Correct Answer: A
Section:

QUESTION 16
A user in Marketing Cloud needs to send an email to a Salesforce Report via a Guided Send process.
How should the consultant meet this requirement?

A. Create a Salesforce Data Extension for the user to select during a Guided Send.

B. Assign the integrated user the Marketing Cloud AppExchange User permission set in Sales Cloud.

C. Create data validation rules for the integrated user in Sales Cloud.

D. Add custom links to the page layouts in Marketing Cloud

Correct Answer: A
Section:

QUESTION 17
A customer wants to send an email from Sales Cloud on behalf of the record owner.
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How should the consultant meet this requirement?
Choose 2 answers

A. Use the Organization-Wide Email address.

B. Use a custom Delivery Profile.

C. Use a custom Send Classification.

D. Use the Send From Record Owner option

Correct Answer: C, D
Section:

QUESTION 18
A customer wants to perform an email send to a subset of a Synchronized Data Extension filtered on custom object data and return tracking to the Sales Cloud.
What approach should the consultant recommend?
Choose 2 answers

A. Use Data Stream to sync Sales Cloud objects to the Marketing Cloud.

B. Use Data Filters or Query Activities to output a Sendable Salesforce Data Extension.

C. Use Query Activities to create a Sendable Synchronized Data Extension.

D. Use Data Filters to segment data to output a Sendable Data Extension

Correct Answer: A, B
Section:

QUESTION 19
Northern Trail Outfitters (NTO):
* Employs Email Specialists responsible for creating content, testing, sending emails, defining the activities for Automation Studio, and creating automations.
* Prefers not to use custom roles unless it is absolutely necessary.
* Email Specialist resides in multiple business units.
Using best practices, how should a consultant create and assign roles for NTO?

A. Create a custom Email Specialist role with needed permissions and assign it to the Email Specialists.

B. Alter the roles of Content Creator and Data Manager by denying permissions and then assign the roles to the ' Email Specialists.

C. Check "Allow" automation permissions for the Content Creator Role and assign it to the Business Units.

D. Check "Allow" automation permissions for the Content Creator Role and assign it to the Email Specialists

Correct Answer: D
Section:

QUESTION 20
Northern Trail Outfitters (NTO) needs to provide an IT staff member with access to Marketing Cloud.
The staff member needs to perform the following tasks:
* Maintain NTO's master suppression list
* Configure data relationships
* Create new subscriber attributes
Which role should be assigned to the IT staff member?

A. Analyst
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B. Data Manager

C. Administrator

D. Content Creator

Correct Answer: B
Section:

QUESTION 21
A customer plans to configure multiple business units (BU) to support the digital marketing efforts of five international offices.
Which reasons warrants this implementation? Choose 2 answers.

A. Support non-English responses with Reply Mail Management.

B. Localized language and display options based on location and culture.

C. Tracking information for campaigns sent by each office.

D. Localized physical mailing address displayed in the default email footer

Correct Answer: B, C
Section:

QUESTION 22
Northern Trail Outfitters (NTO) has doubled in size over the last couple of years. Because of this growth they have decided to organize their company into Business Units to better manage operations.
Which statement is correct regarding the Business Unit functionality within Marketing Cloud?
Choose 2 answers

A. Business Units can have more than one parent Business Unit.

B. Subscribers can only appear in one Business Unit.

C. Business Units can mirror an organization's operational structure.

D. Business Units can share information with other Business Units.

Correct Answer: C, D
Section:

QUESTION 23
A subscriber asked to be removed from a customer's email list multiple times by replying directly to the customer's marketing message, but continues to receive emails.
Which steps will solve how replies are managed by the application?
Choose 3 answers

A. Confirm that Reply Mail Management (RMM) is configured for the customer's account.

B. Confirm that the RMM setting 'Unsubscribe Manual Requests' is set to YES.

C. Confirm that the RMM setting 'Delete auto-replies and out-of-office replies' is set to NO.

D. Confirm that an email address was provided as the Routing Address for Remaining Replies.

E. Confirm that the subscriber's request contained one of the standard terms that qualify for automatic unsubscribe.

Correct Answer: A, B, D
Section:

QUESTION 24
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To fuel their expansion, Northern Trail Outfitters (NTO) recently acquired Eagle Outfitters (EO). There is currently a 30 percent overlap between the guests of each brand and they will be pursuing crossmarketing opportunities.
It was recommended that their Marketing Cloud account now include a separate business unit for EO and the company secure a new sender authentication package for EO using the private domain e-EO.com.
Select the statement that correctly describes the implication of this recommendation.
Choose 2 answers

A. The IP address included in the sender authentication package will have the same reputation as the ones being used for NTO.

B. The EO business unit can also have the NTO authentication package applied simultaneously for cross-marketing emails.

C. The private domain, e-EO.com, will be used for all link wrapping, image URLs, and landing page URLs.

D. The e-EO.com domain will act as the from address for the emails and authenticate using SPF, SenderlD, and DKIM authentication.

E. The email headers for EO will still reflect the private domain for NTO since that is the parent company.

Correct Answer: C, D
Section:

QUESTION 25
The customer has these requirements for storing engagement data in their data warehouse:
* All email open and click activity must be pulled daily from the Marketing Cloud.
* Output files must meet the specific requirements for the data warehouse.
* All the activity must be provided via FTP in one file.
Which automation workflow meets the customer requirements?

A. Report activity that generates Recent Send Summary report > Report delivered directly to FTP

B. Extract activity of Tracking Extracts that combines data into required file > Transfer activity

C. Query activity to pull data view information > Extract activity of data extension > Transfer activity

D. Extract activity of data view tables > Query activity to create the required file > Transfer activity

Correct Answer: C
Section:

QUESTION 26
A daily deal website is concerned with their sender reputation and needs consistent visibility into subscribers who report their email as spam.
How can they determine which subscribers reported their email as spam so they can flag those records in their customer service database?

A. An automation that queries the Complaint data view.

B. An automation that generates the Unsubscribe Event Extract.

C. An automation that queries the Unsubscribe data view.

D. An automation that generates the Complaint Tracking Extract.

Correct Answer: A
Section:

QUESTION 27
What is a correct statement about Send Log data?
Choose 3 answers

A. Can be accessed via Query activities.

B. Can be incorporated into standard reports.
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C. Can be stored for a set period of time.

D. Can be added to a standard data view.

E. Can be included in measures and filters.

Correct Answer: A, C, E
Section:

QUESTION 28
Which data object should be used in conjunction with data extensions to create an opt- down strategy for customers?

A. Profile attributes

B. Preference attributes

C. Publication Lists

D. Preference Lists

Correct Answer: C
Section:

QUESTION 29
What are data extension data retention policies?

A. Settings to "soft" delete all data in a Data Extension so there is no data loss.

B. Settings to control when a data extension creates a back-up of the data it contains.

C. Settings to define when a data extension or the data within the data extension is deleted.

D. Settings to prevent users from deleting a Data Extension created by another user.

Correct Answer: C
Section:

QUESTION 30
A customer would like to store financial data related to invoicing in its data extensions.
Which field type should be used?

A. Currency

B. Decimal

C. Number

D. Float

Correct Answer: B
Section:

QUESTION 31
A consultant needs to send an email to subscribers who have made a purchase. The data used for the send exists on two data extensions--Subscribers and OrderTable, and the customer would like to include key information
from both tables, such as:
* CustomerlD
* FirstName
* EmailAddress
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* OrderlD
* OrderDate
* ShippedDate
Which SQL statement should the consultant use?

A. SELECT T1.CustomerID, T1.FirstName, T1. EmailAddress, T2.OrderlD, T2.0rderDate, T2.ShippedDate FROM ' Subscribers OUTER JOIN OrderTable ON Subscribers.CustomerlD=OrderTable.CustomerlD

B. SELECT * FROM Subscribers WHERE CustomerlD, FirstName, EmailAddress, OrderlD, OrderDate, ShippedDate - JOIN OrderTable On CustomerlD=CustomerlD

C. SELECT CustomerlD, FirstName, EmailAddress, OrderlD, OrderDate, ShippedDate FROM Subscribers INNER JOIN OrderTable ON CustomerlD=CustomerlD

D. SELECT T1.CustomerID, T1.FirstName, T1.EmailAddress, T2.OrderlD, T2.OrderDate, T2.ShippedDate FROM Subscribers T1 INNER JOIN OrderTable T2 ON T1.CustomerID=T2.CustomerID

Correct Answer: D
Section:

QUESTION 32
A customer provides a file containing only new and updated subscriber records exported from its marketing database.
* The file will be uploaded to the customer's Enhanced FTP automatically at 3AM daily.
* The customer requires that the import completes prior to 4AM.
* On average, the file will contain about 2 million rows of data each day.
Based on the customer's requirements and recommended best practices, how should the daily file be imported?

A. Import the file to a data extension, using the 'add and update' method.

B. Import the file to a list, using the 'update only' method.

C. Import the file to a list, using the 'add and update' method.

D. Import the file to a data extension, using the 'overwrite' method.

Correct Answer: A
Section:
Explanation:
Since Record count in more than 500 K so DE is used. New and Update is already specified in question.

QUESTION 33
Subscribers are collected on a customer's website whose subscription database of record is Salesforce Marketing Cloud. The customer sends up to 5 emails per week based on subscriber activity.
The list is:
* Compiled in a database in the website Content Management System (CMS).
* Imported into Marketing Cloud nightly at 11 p.m.
What action should be taken if a third party is sending a message for the customer outside of the Marketing Cloud?

A. Engagement metrics will be passed into Marketing Cloud.

B. They will need to integrate with the Marketing Cloud SOAP API.

C. Unsubscribes should be synchronized between senders.

D. The third-party send list should be pulled from the CMS

Correct Answer: B
Section:

QUESTION 34
What is a correct statement about a database of record? Choose 2 answers
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A. A database of record is a centralized storage repository of data about objects or people.

B. A database of record is any database containing subscriber data.

C. A database of record is a data structure in which multiple opt-in statuses can be stored for a subscriber.

D. A database of record is a system in which a subscriber's status is maintained

Correct Answer: A, D
Section:

QUESTION 35
A bank wants to send out a series of emails to new customers that open a checking or savings account. The emails will be used to educate and inform customers regarding their current account and other bank offerings * Data
for the campaign will be in two data extensions: Customer and New Accounts * The Customer data extension is currently used for multiple campaigns and is updated at 1:00 a.m.
* The New Accounts data is encrypted and will be placed on the FTP at 10:00 p.m.
Which automated workflow meets the customer's requirements?

A. A scheduled automation that starts at 2:00 a.m. that executes Data Extract Activity, Import Activity, Query Activity, Wait Activity, and Send Email Activity.

B. A triggered automation that executes File Transfer Activity, Import Activity, Query Activity, Wait Activity, and Send Email Activity.

C. A scheduled automation that starts at 2:00 a.m. that executes File Transfer Activity, Import Activity, Query Activity, Wait Activity, and Send Email Activity.

D. A scheduled automation that starts at 12:00 a.m. and executes a File Transfer Activity, Import Activity, Query Activities, Wait Activity, and Send Email Activity.

Correct Answer: C
Section:

QUESTION 36
A company collects subscriptions on its website. It does the following:
* Compiles that subscription list in a database in the website Content Management System (CMS).
* Posts this encrypted list to Marketing Cloud nightly at 11 p.m.
* Uses Marketing Cloud as the database of record.
* Sends up to five emails a week based on subscriber engagement with prior sends.
Which automation sequence (excluding waits) should cover these requirements?

A. File Transfer, Data Extract, Filters, Sends

B. File Transfer, Query, Measures, Sends

C. File Transfer, Import, Measures, Sends

D. File Transfer, Import, Query, Sends

Correct Answer: D
Section:

QUESTION 37
A customer needs to import data from an SFTP site. The customer wants to:
* Segment the contents of the file and then send emails.
* Transfer the file to the SFTP site at various times daily.
* Send to data extensions.
Which workflow should meet these requirements?

A. Triggered Automation: Import File > SQL Query(s) > Send Email(s)

B. Scheduled Automation: Transfer File > Import File > SQL Query(s) > Send Email(s)
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C. Scheduled Automation: Import File > SQL Query(s) > Send Email(s)

D. Triggered Automation: Import File > Group Refresh > Send Email(s)

Correct Answer: A
Section:

QUESTION 38
A customer is collecting data from a Smart Capture form that stores submissions in a data extension.
The customer wants an email sent to the marketing manager each morning that contains the previous day's submissions as a CSV attachment. Assuming that the customer has the attachments feature enabled.
Which automation workflow will accomplish this?

A. Triggered Automation: Data Extract > SQL Query > Transfer File > Send Email

B. Scheduled Automation: Data Extract > SQL Query > Transfer File > Send Email

C. Triggered Automation: SQL Query > Data Extract > Transfer File > Send Email

D. Scheduled Automation: SQL Query > Data Extract > Transfer File > Send Email

Correct Answer: D
Section:

QUESTION 39
A customer wants to automate the send of a monthly promotional email. The customer will upload an audience file to their account's Enhanced FTP on a monthly basis on the 15th day of each month, expecting the email to
be deployed upon completion of the import activity. However, if the 15th of the month falls on a Saturday or Sunday, the customer will provide the file on the Friday prior to the 15th and expect the promotional email to be
sent on that Friday.
Given the customer's requirements, which method should be used to automate their monthly promotional email?

A. Create a triggered automation that includes an import activity and triggered send.

B. Create a scheduled daily automation that includes an import activity and user-initiated send.

C. Create a scheduled monthly automation that includes an import activity and triggered send.

D. Create a triggered automation that includes an import activity and user-initiated send.

Correct Answer: D
Section:

QUESTION 40
A customer would like to send a quarterly re-engagement email to subscribers who have not opened in the previous three months. The customer's plans are to:
* Use an existing Paste HTML email for the first send.
* Make only minor changes to the email creative for future sends.
* Use an existing Measure to build the subscriber audience for current and future sends.
* Deploy emails manually for now, but possibly automate in the future.
Which configuration is recommended for the re-engagement email send?

A. Triggered Send

B. Guided Send

C. Automated Send

D. User-Initiated Send

Correct Answer: D
Section:
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QUESTION 41
A customer wants to display a subscriber's first name and the date of send in its monthly newsletter.
Subscriber first name data is stored in a data extension that will not be used in the send definition.
Which option should be in this scenario?

A. Personalization strings

B. AMPscript

C. SQL Query

D. Guide Template Language

Correct Answer: B
Section:

QUESTION 42
A customer has several values that need to be used in the body of an email send:
* The data would be stored in a reference data extension, related on SubscriberKey.
* There may be one or more records for each subscriber.
* The audience is generally over 1 million subscribers.
* The content is time sensitive and should be sent as quickly as possible.
* The customer is not using "catch and release" sending.
* The reference data extension contains 25 columns.
Which method should be used?

A. AMPscript a single Lookup Function

B. Server Side Javascript a single LookupOrderedRows Function

C. AMPscript a single LookupOrderedRows Function

D. Dynamic content via the Dynamic Content Wizard

Correct Answer: C
Section:

QUESTION 43
Which statement is correct regarding tracking aliases? Choose 2 answers

A. Tracking aliases are found in Tracking and some standard reports.

B. Tracking aliases are associated with a URL in HTML as: tag="alias text".

C. Tracking aliases can differentiate click activity in an email to the same URL.

D. Tracking aliases are primarily relevant when used with email conversion tracking.

Correct Answer: C, D
Section:

QUESTION 44
Which statement is correct regarding tracking aliases? Choose 2 answers

A. Tracking aliases are found in Tracking and some standard reports.

B. Tracking aliases are associated with a URL in HTML as: tag="alias text".
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C. Tracking aliases can differentiate click activity in an email to the same URL.

D. Tracking aliases are primarily relevant when used with email conversion tracking.

Correct Answer: C, D
Section:

QUESTION 45
What is a capability of the Import within Contact Builder? Choose 2 answers

A. The data source can be a local file, data filter, or file on any FTP.

B. The target destination can be a DE, list, or All Contacts for Mobile Push or Connect.

C. Like the Import Wizard, the Contact Builder import definition can be executed without saving.

D. In order to use Map by Header Row, the fields in the DE and file must match exactly.

Correct Answer: B, D
Section:

QUESTION 46
When more than one subscriber email address field is created within Contact Builder, what action tells the platform which email address to prioritize in the Email application?

A. Create a new Attribute Group referencing all email address fields in Data Designer.

B. Create a new Import to populate subscriber email addresses into All Subscribers.

C. Add all email address fields into the Mobile Application and Predictive Intelligence Applications.

D. Add all email address fields into the Contact Configuration screen in the correct order

Correct Answer: D
Section:

QUESTION 47
An existing triggered send needs to be updated with new content
Select the correct sequence

A. Pause message interaction, Edit message content, Publish changes, Start triggered email interaction

Correct Answer: A
Section:

QUESTION 48
Northern Trail outfitters needs to reduce the amount of work when managing messages to customers, but cannot add any more personnel due to budget constraints. There has been an increased number of customer
purchases on their website, and the team currently sends batch order confirmations.
What solution will decrease manual workloads on the team and will improve their customers' experience?

A. A scheduled automation to send emails to customers who made a purchase daily

B. A triggered automation to send emails to customers who have made a purchase

C. A triggered message to send an email as soon as a customer completes a purchase

D. A user-initiated message to send an email to customers who made a purchase daily
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Correct Answer: C
Section:

QUESTION 49
A customer wants to automate a series of three emails as part of a Membership renewal drip campaign.
* Email #1 will be sent one month prior to the member's renewal date
* Email #2 will be sent one week prior to the member's renewal date
* Email #3 will be sent on the member's renewal date
* A master audience is updated in real time via the API
Which steps should be included in the customer's automation?

A. Import activity -> Three filter activities -> Three send definitions to the filtered audiences

B. Three send definitions to the master data extension

C. Import activity -> Three send definitions to the master data extension

D. Three filter activities -> Three send definitions to the filtered audiences

Correct Answer: D
Section:

QUESTION 50
n online retail customer needs daily promotional email content to generate with minimal time spent on creation. Their service contract includes building a custom dynamic template for this purpose. The customer has
communicated the following:
* The email content will highlight new inventory each day.
* A small team will run both their digital marketing operations and their email program.
* A user needs to build, test, and send a daily email in less than an hour.
* Images for the emails will be hosted on their website CMS.
Which question is relevant to identify strategies for designing the custom template for the customer's daily promotional email?
Choose 3 answers

A. Will image URLs be available publicly?

B. How often will the layout of the content in a content area change?

C. What is the maximum file size of the images being used?

D. How often will email content be image-only with text overlaying images?

E. What from name will be used for these emails?

Correct Answer: A, B, C
Section:

QUESTION 51
A publishing company presented the following: A need to send renewal reminders to customers whose subscribers expire in 7 days and 15 days. A campaign needs to created and managed by a general marketing user who
will not have administrative rights and who is not technical. The customer's expiration data is included in the data filter.
Which three components should the customer's solution include?

A. Data Filter

B. Template Based emails

C. Suppression List

D. Automation Studio
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E. Triggered Send

Correct Answer: A, B, D
Section:

QUESTION 52
Which three statements about Send Log Data is correct?

A. Uses Measures, filters and programs

B. Accessed using query

C. Can be viewed in standard report

D. Can be stored for periods of time

E. Added to a standard view

Correct Answer: A, B, D
Section:

QUESTION 53
A retail company needs to create journeys that will target subscribers based on website behavior.
They have identified three separate groups:
* Customer who searched for an item on their website
* Customers who abandoned a cart on their website
* Customers who made a purchase on their website
Which three questions should the consultant ask in order to design the data structure to this solution?
Choose 3 answers:

A. Should customers exit the journey when the goal is met?

B. How are the subscribers identified in your web analytics?

C. How many messages should be included in each journey?

D. Should a single customer exist in multiple journeys at the same time?

E. How long after the behavior occurs will a subscriber need to enter a journey?

Correct Answer: B, D, E
Section:

QUESTION 54
Utilizing journey builder interactions for sending post-purchase communications to customers, what contact entry mode fits?

A. Re-entry anytime

B. Re-entry only after exit

C. No re-entry

Correct Answer: A
Section:

QUESTION 55
A customer has several values that need to be used in the body of an email send.
* The data would be stored in a reference data extension, related on SubscriberKey * There may be one or more records for each subscriber * The audience is generally over 1 million subscribers * The content is time sensitive

IT Certification Exams - Questions & Answers | Vdumps.com

https://vdumps.com


and should be sent as quickly as possible * The customer is not using "Catch and release" sending * The reference data extension contains 25 columns What method should be used

A. AMPScript a single LookupOrderRows function

B. Dynamic content via the Dynamic content wizard

C. Server side JavaScript a single LookupOrderedRows function

D. AMPScript a single lookup function

Correct Answer: A
Section:

QUESTION 56
As part of their brand guidelines, NTO uses a custom brand font for all print marketing materials.
NTO wants to use their custom brand font in email as well.
What is the recommended best practices for font usage in email?

A. Use a web-safe font for text that closely matches the brand's custom font.

B. Build an email as one image, with all text saved in the brand font.

C. Edit an email's HTML to list the custom brand font in the style tag's font-family property.

D. Build an email using multiple images, with all text saved in the brand font.

Correct Answer: A
Section:

QUESTION 57
A retail company's database of record resides at a 3rd-party company that also keeps track of purchase history. That database only updates once a day where new records can be created and merged. The database uses an
"Email ID," which is a numeric field that represents both the business unit and email address. The company now wants to be able to send real-time Welcome emails to people (newly registered website users) who provide
their email address in exchange for getting 10% off their first order, and ensure this send is connected to "Email ID" in the database.
What key issue should be addressed? Choose 3 answers

A. How will Marketing Cloud and the database sync up?

B. Will new users have an "Email ID"?

C. What will be used as the Subscriber Key?

D. What publication lists will be used?

E. Will the company need a custom preference center?

Correct Answer: A, B, C
Section:

QUESTION 58
Northern Trail Outfitters is noticing a gradual decline in the percentage of conversions per emails sent in their digital marketing campaign. A new initiative is being adopted to reverse the trend.
What action should be taken to increase subscriber engagement? Choose 2 answers

A. Increase volume of emails to a wider audience

B. Increase the use of dynamic content in emails

C. Adopt a Cart Abandonment Email Campaign

D. Introduce more identity verification steps in check out process
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Correct Answer: B, C
Section:

QUESTION 59
NTO has to import a file that will be different every time.
What method should be used?

A. Update

B. Overwrite

C. Add and Update

D. Add Only

Correct Answer: B
Section:

QUESTION 60
NTO wants to import files at certain standard times, but occasionally a file will be dropped on a Friday if the 30th of the month falls on a weekend.
What is the flow?

A. A user-initiated message to send an email to customers who made a purchase daily.

B. Triggered Import - user initiated send (not scheduled).

C. A scheduled automation to send emails to customers who made a purchase daily.

Correct Answer: B
Section:
Explanation:
If a question is related to automation and it mentions that a file will be available in the FTP always at a specific time, your answer will be an option with a scheduled automation. Scheduled automations are used when you
know the time a file is pushed into FTP and it always runs at a scheduled time. If a question is related to automation and there is an uncertainty when the file will be pushed to FTP (ex; a day before last working day / if a date
falls on a weekend, it will be available on last Friday etc.), your answer will be an option with a Triggered Automation. Triggered Automations are fired as soon as a file hits a specific location within FTP. Transfer activity is
involved when file in encrypted.

QUESTION 61
What are the similarities between Automation Studio and Journey Builder?

A. Have duration plus wait activity

B. Ability to define an email send

C. Fire an event from Automation Studio to Journey Builder

Correct Answer: C
Section:

QUESTION 62
If I want to introduce a new line of footwear. I am excluding anyone who does not have shoe as an attribute listed in their preference center. I plan to send the emails daily. After a short time, I notice many people updating
their preferences, and less emails are going out.
What is the issue causing less emails to go out? Select one.

A. High Watermark if journey builder

B. Preference center is too strict
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C. Deliverability issues on account

D. Email frequency too high

Correct Answer: A
Section:

QUESTION 63
Tracking Alias question:

A. Same URL

B. Email Conversion Tracking

C. Can be found in some reports

D. Differentiate clicking email

Correct Answer: A, B, C, D
Section:

QUESTION 64
What is the skill set you need to build emails with dynamic content?

A. CSS

B. HTML

C. Ampscript

D. SSJS

Correct Answer: C
Section:

QUESTION 65
How do you add a contact in contact builder?
Choose 2

A. Import to MyLists

B. Import to All Subscribers List

C. Import to DE

D. Add manually to All Subscribers

Correct Answer: A, C
Section:

QUESTION 66
How do I set up an individual who manages Marketing Cloud operations across channels, mobile, and social? Choose two.

A. Marketing Channel Manager Role

B. Regional or Local Administrator Role

C. Marketing Cloud Administrator Role

D. Email marketing manager role
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Correct Answer: A, C
Section:

QUESTION 67
A customer executes a large number of sends via Marketing Cloud connect and is concerned about API limits. What should the consultant suggest to minimize the impact of Marketing Cloud Connect on daily API limits?
Choose Two

A. Upgrade the MC account to ConnectedApp

B. Turn off link details tracking

C. Filter data

D. Turn off Individual Level Tracking

Correct Answer: A, D
Section:

QUESTION 68
Northern Trail Outfitters has purchased a new Marketing Cloud account with two dedicated IP addresses. One IP address will be used for commercial sends, while the other will be reserved for transactional messages.
Their customer base includes 1.5 million email addresses.
What should the consultant recommend?

A. Suppress sends to AOL email addresses during the first two weeks of IP warming, then resume sending to them during the third week.

B. Send to unengaged subscribers during the first two weeks of IP warming in order to give them the opportunity to interact.

C. Focus on warming the IP address for commercial sends, because it is not necessary to warm an IP address used only for transactional sends.

D. Split marketing campaigns over a number of days while migrating over smaller triggered campaigns during the warming period.

Correct Answer: D
Section:

QUESTION 69
A customer team wants to retarget subscribers who click on links of key items promoted across email campaigns. Click activity will be cross-referenced with subscribers' regional markets on a master subscriber data extension.
What skill set should the customer team have for this solution to be viable?

A. HTML

B. SSJS

C. AMPscript

D. SQL

Correct Answer: B
Section:

QUESTION 70
A Marketing Cloud user needs the email addresses of everyone who unsubscribed from a particular email send. This user does NOT know SQL and does NOT have access to the Enhanced FTP account.
What functionality should be used to retrieve the necessary data?

A. My Tracking

B. My Reports

C. Tracking Extract
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D. Data Views

Correct Answer: A
Section:
Explanation:
With my Tracking user can create a list, view in browser or download as an attachment with the subscribers meeting the criteria

QUESTION 71
Which two statements about a database of record are correct? Choose 2 answers

A. It is a centralized storage repository of data about objects or people.

B. It is any database containing subscriber data.

C. It is any data structure in which multiple opt-in statuses can be stored for a subscriber.

D. It is a system in which a subscriber's status is maintained.

Correct Answer: A, D
Section:

QUESTION 72
Northern Trail Outfitters (NTO) wants to use dynamic content within their emails to provide customers with more personalized communications. This includes using a Dynamic Sender Profile to customize the From Name and
From Email Address to use the regional store managers' information.
If a new manager is assigned to a region, NTO wants to update the information in one place.
What data should a consultant ensure exists within Marketing Cloud in order to facilitate this?

A. Regional store manager's name and email address for each customer.

B. Each customer's region code and the manager's name and email address for each region code.

C. Name and email address for each regional store manager stored on a lookup table.

D. Region code, regional store manager's name, and email address for each customer.

Correct Answer: D
Section:

QUESTION 73
During discovery a consultant confirmed:
*A master audience file containing contact information and data points will be used for segmentation and imported nightly.
*The customer would like to implement a mechanism that consistently prevents sending promotional emails to subscribers who work for their top three competitors.
What feature should a consultant include in the solution?

A. A global unsubscribe

B. An auto-exclusion list

C. An auto-suppression list

D. An exclusion list

Correct Answer: C
Section:

QUESTION 74
A customer will provide a single daily file on the Marketing Cloud SFTP at 3 a.m. and needs an alert if the file is NOT present on time. The file needs to be:
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*Imported iota a staging data extension.
*Separated into two different data extensions.
Which automation should meet these requirements?

A. Scheduled Starting Source: Data Extract > Import File Activity > SQL Query Activity 1 > SQL Query Activity 2

B. File Drop Starting Source: Import File Activity > SQL Query Activity 1 > SQL Query Activity 2

C. Scheduled Starting Source: Import File Activity > SQL Query Activity 1 > SQL Query Activity 2

D. File Drop Starting Source: File Transfer Activity > Import File Activity > Filter Activity > SQL Query Activity 1

Correct Answer: B
Section:

QUESTION 75
Northern Trail Outfitters is expanding its marketing efforts globally. Each country's marketing department has its own business unit and is responsible for the creation and execution of all the marketing campaigns. The
Marketing Cloud Administrator is having trouble keeping up with the consultant influx of new users and would like to speed up the turnaround of granting new users access to Marketing Cloud.
In which two ways could this be accomplished? Choose 2 answers

A. Assign Administration User permissions to the Channel Manager role.

B. Assign Channel Managers the role of Marketing Cloud Analyst.

C. Assign Administration User permissions to each business unit.

D. Assign Administration User permissions to individual users.

Correct Answer: A, C
Section:

QUESTION 76
Which two statements are correct about Send Logging? Choose 2 answers

A. Send Log data extensions are archived automatically based on retention settings.

B. AMPscript can be used to pull data from Send Logs for use within emails.

C. A business unit can support up to three Send Logs.

D. SQL Query Activities can reference Send Logs in combination with system data views.

Correct Answer: B, D
Section:
Explanation:
Send Log data extensions are never archived. Its deleted. A business unit can support only one Send Log.

QUESTION 77
The customer has the following requirements for storing engagement data in their data warehouse:
*All email open and click activity must be pulled daily from Marketing Cloud.
*Output files must meet the specific requirements for the data warehouse.
*All the activity must be provided via SFTP in one file.
Which automation workflow meets the customer requirements?

A. Data Extract Activity of Tracking Extracts that combines data into required file > File Transfer Activity

B. Report activity that generates Recent Send Summary report > Report delivered directly to SFTP
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C. SQL Query Activity to pull data view information > Data Extract Activity of data extension > File Transfer Activity

D. Data Extract Activity of data view tables > SQL Query Activity to create the required file > File Transfer Activity

Correct Answer: C
Section:

QUESTION 78
A restaurant supply company captures email subscribers and leads through trade shows. This has always been a manual process with booth visitors leaving contact information in a fishbowl. The restaurant supply company is
updating their process to an online sweepstakes entry that allows entrants to confirm opt-in for a monthly newsletter.
Which two components are appropriate for this solution? Choose 2 answers

A. CloudPage with Web Collect to add entrants in to a data extension

B. Send Email Activity with a link to a subscription center

C. CloudPage with Smart Capture to add entrants in to a data extension

D. Data extension with double opt-in status defined

Correct Answer: C, D
Section:

QUESTION 79
A customer has an email newsletter to send out, but wants to deliver it with a targeted message for customers within a specified age range. These data have been defined in attributes from a sign-up landing page.
How should the customer individualize the email content?

A. Personalization Strings

B. Substitution Strings

C. Dynamic Content Areas

D. Guide Template Language

Correct Answer: C
Section:

QUESTION 80
A consulting has a data extension that contains all current product information. The customer wants to refresh data each morning by importing a CSV containing today's product catalog. The product catalog is never the same;
products can be added and removed.
Which import type should be used?

A. Overwrite

B. Add Only

C. Add/Update

D. Update Only

Correct Answer: C
Section:

QUESTION 81
In which two ways can Contact Builder be used to affect data stored on a data extension? Choose 2 answers
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A. Reconcile contact data on multiple Contact IDs

B. Add a single record to a data extension

C. Export data from a data extension to any SFTP location

D. Clear the data from a data extension

Correct Answer: A, C
Section:

QUESTION 82
Northern Trail Outfitters assigns a 15-digit integer as their Order ID which will be used as the primary key of a data extension. The import file contains leading zeros, but they will NOT be included in the final values.
Which data type should they use for the Order ID field?

A. Number

B. Text (15)

C. Decimal (15,0)

D. Decimal (15,2)

Correct Answer: C
Section:
Explanation:
The order ID field is conducive because it places all of the items that the customers want under one order. You can imagine how problematic it would be if the rules would be set in different areas. It will be harder for the
company to track the orders of each customer.
This may lead to people receiving items that they did not order or not getting any of the things that they have ordered at all. The order ID field will make everything more organized and correct. The fewer mistakes that the
company makes in processing orders, the happier the customers will be with their shopping experience.

QUESTION 83
North Trail Outfitters (NTO) wants to automate the sending of shipping notices and a customer survey.
*Shipping notices will be sent once a day.
*The shipping file will be placed on the FTP sometime after 4:00 p.m.
*The shipping data will be stored in the shipping Notice data extension.
*A field in the data extension will contain the shipping data.
*The survey needs to be sent at 9:00 a.m., exactly 10 days after the customers order ships.
Which workflow would most effectively enable NTO to do this?

A.

B.

C.
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D.

Correct Answer: A
Section:

QUESTION 84
A university plans to use Journey Builder to improve their 1:1 marketing to potential students, current students, and alumni. The university currently has student data in Sales Cloud. Other data, such as course catalog, student
demographics, and alumni information, is stored in external systems.
Which two actions should be consultant recommend? Choose 2 answers

A. Use Synchronized Data Sources to obtain data from Sales Cloud.

B. Create an Import Activity to import alumni data into Salesforce Report.

C. Create list attribute to store student data from Sales Cloud.

D. Use Data Designer to link student and alumni data to the contact record.

Correct Answer: A, D
Section:

QUESTION 85
A customer wants to segment point of sale system data stored in Marketing Cloud with data from the Contact and Campaign objects in Salesforce.
Which two tools should be used? Choose 2 answers

A. Synchronized Data Extensions

B. Salesforce Reports

C. Filter Activity

D. SQL Query Activity

Correct Answer: A, D
Section:

QUESTION 86
Which two statements are accurate regarding segmentation options in Marketing Cloud? Choose 2 answers
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A. A data extension can be updated using a query activity.

B. A random data extension can be updated with a filter activity.

C. A data filter can be automated with a filter activity.

D. A filtered data extension can be populated with a filter activity.

Correct Answer: B, C
Section:

QUESTION 87
A customer wants to automate the send of a monthly promotional email. The customer will upload an audience file to their account's Enhanced SFTP on a monthly basis on the 15th day of each month, expecting the email to
be deployed upon completion of the import activity. However, if the 15th of the month falls on a Saturday or Sunday, the customer will provide the file on the Friday prior to the 15th and expect the promotional email to be
sent on that Friday.
Which method should be used to automate their monthly promotional email?

A. Create a scheduled monthly automation which includes an Import File Activity and triggered send.

B. Create a file drop automation which includes an Import File Activity and Send Email Activity.

C. Create a file drop automation which includes an Import File Activity and triggered send.

D. Create a scheduled daily automation which includes an Import File Activity and Send Email Activity.

Correct Answer: A
Section:

QUESTION 88
A pharmaceutical company is hosting a monthly event and will be sending an invitation to new local contacts. The customer would like to automatically update a data extension to determine who will be attending.
*The data extension will hold each contact's response as well as the time stamp of the click.
*The contact will receive an email two days after the click event.
*Both emails should be sent via Journey Builder.
What is the optimal solution to record the click activity prior to sending the second email?

A. Use a landing page to record the click and trigger an email.

B. Leverage the Decision Split and create a Custom Activity.

C. Leverage the Engagement Split and the Update Contact Activity.

D. Use a landing page to record the click in the data extension.

Correct Answer: C
Section:

QUESTION 89
Northern Trail Outfitters (NTO) has a requirement to create a distinction between marketing and transactional emails in terms of From Name and IP Address for reputation purposes.
Which two actions should NTO take to create Send Classifications? Choose 2 answers

A. Define a Sender Profile

B. Define a Subscriber-specific From Name

C. Define custom Reply Mail Management

D. Define a Delivery Profile

Correct Answer: A, D
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Section:

QUESTION 90
What functionality is contained in Journey Builder that does NOT exist in Automation Studio?

A. The option to convert a qualified Lead to a Contact.

B. Flexibility to wait based on duration or a specific time.

C. Native execution of a Server-side JavaScript activity.

D. The ability to send an email to a Salesforce audience.

Correct Answer: A
Section:

QUESTION 91
The Corporate Apparel Division of Northern Trail Outfitters (NTO) is moving to Marketing Cloud and will be using NTO's existing account. The Corporate Apparel team has asked for a recommendation on whether they should
have a separate Business Unit.
Which consideration warrants the creation of a separate Business Unit for Corporate Apparel's instance of Marketing Cloud?

A. Brand guidelines for Corporate Apparel is different from NTO

B. Managing Unsubscribes for the Corporate Apparel Division only

C. Sending from a separate IP Address and Domain

D. Using different From Name and Email Address settings

Correct Answer: B
Section:

QUESTION 92
A marketer wants to create and edit email content, as well as generate reports and manage subscriber data.
Using the principle of least privilege, which two pre-defined roles should be assigned? Choose 2 answers

A. Analyst

B. Administrator

C. Data Manager

D. Content Creator

Correct Answer: A, D
Section:

QUESTION 93
A customer wants Sales Cloud users to create and send Marketing Cloud emails.
Which two recommendations should the consultant make? Choose 2 answers

A. Each user should have a one-to-one relationship between the Marketing Cloud user and the Sales Cloud user.

B. The consultant should enable deep linking in the Marketing Cloud Connect configuration.

C. Each Sales Cloud user should have a System Administrator Profile and a Role at the top of the Role Hierarchy.

D. The consultant should enable the Create Email feature on the user Profile in Sales Cloud.
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Correct Answer: A, B
Section:

QUESTION 94
An entertainment customer has added a new business unit for one of its record labels. It has also purchased a Sender Authentication Package (SAP) and owns the branded domain.
What is necessary to complete SAP setup?

A. Route the domain through an IP address unique to the business unit.

B. Configure link wrapping to redirect to the business unit's subdomain.

C. Configure custom Reply Mail Management for the business unit's subdomain.

D. Delegate a specific subdomain to the Marketing Cloud name servers.

Correct Answer: C
Section:

QUESTION 95
A company is hosting a series of events and wants its customers who register to enter into a journey.
Which two methods are viable configurations for entry? Choose 2 answers

A. A form hosted on the company website that fires the entry event via REST API.

B. A Smart Capture form hosted in CloudPages that updates a Profile attribute.

C. A Smart Capture form hosted in CloudPages that populates the entry source.

D. A form hosted on the company website that fires the entry event via SOAP API.

Correct Answer: C, D
Section:

QUESTION 96
A customer needs to link demographic information to its model in Contact Builder.
What type of relationship should be used?

A. One-to-Many

B. One-to-One

C. Many-to-One

D. Many-to-Many

Correct Answer: B
Section:

QUESTION 97
By which three standard methods could contacts be injected into a journey? Choose 3 answers

A. Mobile Response Event

B. Date-Based Event

C. Predictive Intelligence Event

D. CloudPages Form Submit Event

E. Sales/Service Cloud Event
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Correct Answer: B, D, E
Section:

QUESTION 98
An online retailer would like to utilize Journey Builder interactions for sending post-purchase communications to their customers.
What Contact Entry mode best fits this scenario?

A. No re-entry

B. Re-entry anytime

C. Re-entry only after existing

D. Re-entry after time

Correct Answer: C
Section:

QUESTION 99
What are two possible outcomes when "Multipart MIME" is selected during the send process?
Choose 2 answers

A. An auto-generated text version will be sent with your HTML email.

B. A custom text version will be sent with your HTML email.

C. The email will avoid detecting by various SPAM filters.

D. Open and click activity are tracked in either version.

Correct Answer: A, D
Section:

QUESTION 100
Northern Trail Outfitters (NTO) is launching a new campaign, driving it to redesign its data structure.
NTO needs to change the cardinality between two data extensions inside Contact Builder.
What are two consequences of this change? Choose 2 answers

A. All filters created before will adapt automatically to the new cardinality.

B. All scheduled sends using a filter based on one of the data extensions should be reviewed.

C. A contact may NOT show up in the filter based on one of the data extensions.

D. One of the data extensions must be deleted from the attribute group in order to change the cardinality.

Correct Answer: B, C
Section:

QUESTION 101
A customer will provide a single daily file on the Marketing Cloud SFTP at 3 AM and needs an alert if the file is not present on time. The file needs to be: Imported into a staging data extension.
Separated into two different data extensions.
Which workflow should meet these requirements?

A. Scheduled Automation: File Transfer Activity > Import File Activity > SQL Query Activity 1 > SQL Query Activity 2

B. Scheduled Automation: Import File Activity > SQL Query Activity 1 > SQL Query Activity 2
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C. File Drop Automation: Import File Activity > SQL Query Activity 1 > SQL Query Activity 2

D. File Drop Automation: File Transfer Activity > Import File Activity > Filter Activity > SQL Query Activity 1

Correct Answer: B
Section:

QUESTION 102
Northern Trail Outfitters is setting up new hires on its instance of Marketing Cloud, which includes Email Studio, Mobile Connect, and Social Studio. One of the hires needs to manage the operations of all of the North
American Business
Units.
What two roles, custom or standard, could be assigned to this user to meet the requirement?
Choose 2 answers

A. Marketing Cloud Channel Manager

B. Marketing Cloud Email Marketing Manager

C. Marketing Cloud Regional or Local Administrator

D. Marketing Cloud Administrator

Correct Answer: A, D
Section:

QUESTION 103
A customer frequently holds seminars and other events to interface with their customers. They plan to do the following:
*Use SmartCapture forms to write data into event registration data extensions.
*Cross-reference the records in each registration data extension with corresponding invitation email sends.
*Send a follow-up email to customers who click on the registration link in the invitation email, but do not complete registration.
Which skill is needed to build an efficient solution?

A. AMPscript

B. SQL

C. HTML

D. CSS

Correct Answer: A
Section:

QUESTION 104
A customer is developing a new eCommerce section of their website and plans to leverage transactional data in customer journeys.
Which two Marketing Cloud features will support this effort?
Choose 2 answers

A. Data Designer

B. Cloud Pages

C. Web Analytics Connector

D. Content Builder

Correct Answer: C, D
Section:
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QUESTION 105
A retail company's database of record resides at a third-party company which also keeps track of purchase history. Their database only updates once a day where new records can be created and merged. The database uses
the unique identifier "Customer ID".
The company wants to send real-time Welcome emails to newly registered website users who provide their email address in exchange for getting 10% off their first order, and ensure this send is connected to "Customer ID" in
the database.
Which three key issues should be addressed?
Choose 3 answers

A. What publication lists will be used?

B. Will the company need a custom preference center?

C. How will Marketing Cloud and the database synchronize?

D. Will new users have a "Customer ID"?

E. What will be used as Subscriber Key?

Correct Answer: C, D, E
Section:

QUESTION 106
A retail company does business in both the United States and Canad a. They have a loyalty program in which a customer can enroll. The company will provide a presegmented customer file, per campaign, which has a
"Version" data field indicating the type of email the customer is to receive.
Which two questions should be asked to determine a data/segmentation strategy?
Choose 2 answers

A. Will a lookup table is needed for a dynamic From Name?

B. Will customers be able to sign up for the loyalty program at the store?

C. Is the purpose of these emails for acquisition or retention or transactional?

D. Will "Version" values/meanings change, precluding reusable AMPscript?

Correct Answer: A, C
Section:

QUESTION 107
A customer wants to send a quarterly reengagement email to subscribers who have NOT opened in the previous three months. The customer's plans are to:
• Use an existing Paste HTML email for the first send.
• Make only minor changes to the email creative for future sends.
• Send to the subscriber list.
• Deploy emails manually for now, but possibly automate in the future.
Which send method should be used?

A. Guided Send

B. Triggered Send

C. Send Flow Activity

D. Send Email Activity

Correct Answer: C
Section:

QUESTION 108
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A customer needs to import data from an SFTP site. The customer wants to:
• Segment the contents of the file and then send emails.
• Transfer the file to the SFTP site at various times daily.
• Send to data extensions.
What sequence of automation activities should meet these requirements?

A. Scheduled: Import File > SQL Query(s) > Send Email(s)

B. Scheduled: Transfer File > Import File > SQL Query(s) > Send Email(s)

C. File Drop: Import File > SQL Query(s) > Send Email(s)

D. File Drop: Import File > Group Refresh > Send Email(s)

Correct Answer: C
Section:

QUESTION 109
A customer wants to perform an email send to a subset of Synchronized Data Extension referencing Sales Cloud custom object data and return tracking to Sales Cloud.
Which two approaches should the consultant recommend?
Choose 2 answers

A. Use Synchronized Data Source to sync Sales Cloud objects to Marketing Cloud.

B. Use SQL Query Activities to output a Sendable Salesforce Data Extension.

C. Use SQL Query Activities to create a Sendable Synchronized Data Extension.

D. Use Data Filters to segment data to output a Sendable Data Extension.

Correct Answer: A, B
Section:

QUESTION 110
Northern Trail Outfitters (NTO) wants its monthly distributor newsletter email to appear to be sent on behalf of the subscriber's account representative without segmenting the audience by sales representative.
In which two ways could this distributor-specific sender profile be configured in a Marketing Cloud account with Sender Authentication Package implemented?
Choose 2 answers

A. Pick "Choose from list," selecting the From Name and From Email values from the list of account users.

B. Match the external keys of the sender profile and data extension containing account representative details.

C. Utilize AMPscript data extension lookups to dynamically populate the From Name and From Email values.

D. Use substitution strings to populate the From Name and From Email values in the sender profile.

Correct Answer: C, D
Section:

QUESTION 111
A company collects subscriptions on its websites. It does the following:
• Compiles that subscription list in a database in the website content Management System (CMS).
• Posts this encrypted list to Marketing Cloud nightly at 11 p.m.
• Uses Marketing Cloud as the database of record.
• Sends up to five emails a week based on subscriber engagement with prior sends.
What automation sequence (excluding waits) should cover these requirements?
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A. File Transfer > Import File > Measures > Send Email

B. File Transfer > Import File > SQL Query > Send Email

C. File Transfer > SQL Query > Measures > Send Email

D. File Transfer > Data Extract > Filters > Send Email

Correct Answer: B
Section:

QUESTION 112
Which three statements are correct regarding the automation tools in Marketing Cloud?
Choose 3 answers

A. Automation Studio and Journey Builder allow users to repeat an interaction indefinitely.

B. Journey Builder allows users to inject Contacts from a data extension which is updated by Automation Studio.

C. Journey Builder allows users to update a contact record in a journey or import data into a data extension.

D. Automation Studio and Journey Builder allow users to define a wait activity based on duration.

E. Automation Studio and Journey Builder allow users to define the parameters of a send within the tool.

Correct Answer: A, B, E
Section:

QUESTION 113
Northern Trail Outfitters (NTO) uses the SAP domain comms.nto.com and has just opened an office in Australi a. They have created a business unit for their new office and want to use the domain comms.nto.com.au to send
emails to their Australian customers.
What would be required to enable sending emails from their new domain without impacting deliverability?

A. An additional IP address

B. An additional Sender Authentication Package

C. An additional private domain

D. Register the new domain in Setup > From Address Management

Correct Answer: A
Section:

QUESTION 114
Northern Trail Outfitters receives data from their point-of-sale system every night. The file is placed on their Enhanced FTP, but there is not a consistent time or naming convention for the file.
In which two ways should they set up their automation to import the data from the file on a nightly bais? (Choose 2 answers)

A. %%BASEFILENAME_FROM_TRIGGER%%

B. %%BASEFILENAME_FROM_FILEDROP%%

C. Scheduled Starting Source

D. File Drop Starting Source

Correct Answer: B, D
Section:

QUESTION 115
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Northern Trail Outfitters uses a Salesforce Data Entry Source in their Journey that injects Salesforce Orders when they are either created or updated with a status of New, Currently Knitting Shipped, and Complete. Their
Journey works when orders are created, but they notice that it does not inject customers when their status is updated.
What could be causing this?

A. The associated Contact should be updated to be injected

B. Synchronized Data Sources poll for changes every 15 minutes at the quickest

C. Orders are not being updated from not meeting criteria to meeting criteria

D. Orders should be set up to allow injection upon update in Connect Configuration

Correct Answer: C
Section:

QUESTION 116
Northern Trail Outfitters and its subsidiaries use Sales Cloud and Marketing Cloud to send customers frequest email communications of new products and updates on their portfolios. They have noticed the messages and
branding being sent varies greatly and would like to create a bether customer experience.
What extension product should be considered to unify the messaging and branding of these communications while still allowing personalization and timing of campaigns?

A. Distributed Marketing

B. Einstein Content Selection

C. Marketing Cloud Connect

D. Distributed Sending

Correct Answer: A
Section:

QUESTION 117
Northern Trail Outfitters has a customer login page on their website and wants to use Marketing Cloud to send an email to customers who need to reset their password. The email needs to be sent as quickly as possible. Their
web server should receive a notification when the email is sent.
Which solution should they use?

A. Triggered Send Definition

B. Transactional Messaging API

C. Multi-Step journey with an API Event entry source

D. Single Send journey with an API Event entry source

Correct Answer: B
Section:

QUESTION 118
Northern Trail Outfitters wants to build an abandoned cart journey which includes a Decision Split that evaluates if a customer has made a purchase after they enter the journey. Customer data is stored in a master data
extension ans purchase data is stored in a second data extension.
Which two steps should they include to accomplish this journey?

A. Use Data Designer in Contact Builder to relate the two data extensions.

B. Utilize Entry Data on a Decision Split within Journey Builder.

C. Create a Data Relationship in Email Studio to relate the two data extensions.

D. Configure activities within Automation Studio to update the purchase data.
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Correct Answer: A, D
Section:

QUESTION 119
Northern Trail Outfitters wants to send an email to one million contacts in Sales Cloud. The criteria to segment contacts include using 10+ fields to segment.
Which process should the consultant utilize for a reliable send method?

A. Query Synchronized Data Extensions using a query activity to a Salesforce Data Extension, then send via Email Studio Send Flow

B. Import Salesforce Report through an import activity to a Salesforce Data Extension, then send to data extension using Email Studio email send

C. Assign the one million contacts from the report to a Salesforce campaign, and use a Single Step journey with Salesforce Campaign as an entry event

D. Send to a Salesforce Report from Marketing Cloud using Email Studio Send Flow

Correct Answer: A
Section:

QUESTION 120
Northern Trail Outfitters (NTO) wants to use Marketing Cloud to solicit customer service feedback. If a customer indicates they are unhappy with the service they have received, NTO wants a new case to be created in Service
Cloud. NTO is unsure of what is possible within Marketing Cloud but would like to use as much native functionality as possible.
What approach would a consultant recommend?

A. Use an Engagement Split to capture positive responses, and a Case Activity to create a new case in Service Cloud.

B. Use Automation Studio to capture positive or negative responses, and a Case Activity to create a new case in Service Cloud.

C. Use an AppExchange package to create a customized API integration between Marketing Cloud and Service Cloud.

D. Use an Engagement Split to capture positive or negative responses, and a Custom Activity to create a new case in Service Cloud.

Correct Answer: D
Section:

QUESTION 121
Northern Trail Outfitters receives a nightly encrypted unsub file to their Marketing Cloud SFTP from a third-party email platform. These files are used to unsubscribe existing subscribers. They do not use Email Address as
Subscriber Key.
What Automation Studio Activity sequence should be used to ensure the appropriate subscribers are unsubscribed from the All Subscriber List?

A. Import File > Data Extract > File Transfer > Import File

B. File Transfer > Import File > Query > Data Extract > File Transfer > Import File

C. Import File > Query > Data Extract > File Transfer > Import File

D. File Transfer > Import File > Data Extract > File Transfer > Import File

Correct Answer: B
Section:

QUESTION 122
A customer wants to set up a real-time, API-driven way to be alerted when transactional messages fail to send out of Marketing Cloud. They are currently in the process of hiring a full-time developer but want an
implementation in place for the developer to maintain.
What should the customer have in place to ensure this solution can be implemented?

A. A Transactional Journey with the Not Sent Notification activity included

IT Certification Exams - Questions & Answers | Vdumps.com

https://vdumps.com


B. A Datorama instance to ingest their data

C. An external system to receive and confirm callback and subscriptions

D. An Interaction Studio instance to ingest their data

Correct Answer: C
Section:

QUESTION 123
A retail customer expanded their portfolio to include additional product lines in addition to their already popular offerings. They want to give subscribers the ability to unsubscribe via email from the specific subsections while
still remaining on the main commercial communications audience. This option will be included in the footer attached to the unsubscribe URL and as an option on their subscription center.
Which model would meet the requirements?

A. Publication List with Lists

B. Publication List with Data Extensions

C. Exclusion List with Lists

D. Exclusion List with Data Extensions

Correct Answer: B
Section:

QUESTION 124
Northern Trail Outfitters (NTO) send emails from Content Builder and Journey Builder. When subscribers reply to an email, NTO would like to send an auto-reply message using a pre-defined HTML email that explains email
replies are unmonitored and they should call NTO for any inquiries.
How could these auto-reply messages be enabled?

A. From the Reply Mail Management settings page, choose the 'Create Custom Response' option under 'Automated Response Email for Remaining Replies' section and select the HTML email from the 'define email' link.

B. Create a Triggered Send and on the Reply Mail Management settings page, choose the 'Create Custom Response' option under 'Automated Response Email for Remaining Replies' section, then select the Triggered Send
email.

C. Create a Triggered Send and from a Sender Profile properties page, enable 'Custom Reply Mail Management Settings', 'Use Auto Reply' and 'Reply using triggered send' options, then select the Triggered Send email.

D. Open Admin > Account Setting page in Email Studio and in the 'Auto Reply Email' section, select 'Custom' and paste the HTML email code into the text area field.

Correct Answer: A
Section:

QUESTION 125
Northern Trail Outfitters wants to query Marketing Cloud for send data across SMS, Push, and email.
What would a consultant recommend?

A. Contact History

B. Send Logs

C. Tracking Extracts

D. _Send Data Views

Correct Answer: B
Section:

QUESTION 126
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A consultant configured a triggered send definition in Sales Cloud for a customer using Marketing Cloud Connect, The trigger is on a Custom Object called 'Shipments' and is enabled for Triggered Sends in Setup.
Which two configuration requirements should be considered when troubleshooting? (Choose 2 answers)

A. The Shipment object is on the Account Related List.

B. There is a Master Detail Relationship from Contact to Shipment.

C. The Shipment object requires a Lookup to Lead or Contact.

D. An Apex Trigger is created on the Shipment object.

Correct Answer: A, D
Section:

QUESTION 127
Northern Trail Outfitters wants to import new contacts gathered from an external web form. The entries are being collected at high frequency, potentially thousands per minutes. The data does not need to be immediately
ingested into Marketing Cloud as it is used in a daily scheduled automation.
What Should be recommended?

A. Create this as a Journey Data Source via Journey Builder.

B. Push each new record into Marketing Cloud vis Platform Event API on form submit.

C. Perform a daily bulk export to SFTP for import via Automation.

D. Recreate this external web form inside Marketing Cloud.

Correct Answer: C
Section:

QUESTION 128
Northern Trail Outfitters recently purchased Marketing Cloud to start running cross-channel campaigns. They are looking for guidance on which value to use as the subscriber key.
Which two options should the consultant recommend? (Choose 2 answers)

A. Email

B. CRM ID

C. Mobile Device ID

D. Loyalty Program Number

Correct Answer: A, D
Section:

QUESTION 129
Northern Trail Outfitters maintains their primary customer identity in their ERP system but managers their customer service via Service Cloud. Customer data is updated in real-time based on changes in the ERP, and the ERP
customer ID serves as the Customer Key. They want to leverage Synchronized Data Extensions to import data about cases from Service Cloud every 15 minutes.
What consideration should be made before implementing this solution?

A. Moving to use the email address as the contact key would simplify the integration since it is common to both systems.

B. Marketing Cloud will deduplicate customers based on their email address, meaning some customers may be overwritten or not receive email.

C. The number of contacts added to the instance will be approximately twice as large by using this integration pattern.

D. They will have to migrate to use Service Cloud IDs, such as the Contact ID, as the contact key instead of ERP IDs.

Correct Answer: D
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Section:

QUESTION 130
Northern Trail Outfitters has determined they will initially deploy messaging to email and SMS channels, but also plan for social advertising. Customer data originates within their point-of-sale system which communicates to
Marketing Cloud in real-time via API. They want to configure their customer data for long-term cleanliness and maintainability.
Which two best practices should be utilized? (Choose 2 answers)

A. Configure Contact Builder to automatically generate a unique subscriber key.

B. Define the subscriber key as a unique value that does not relate to a specific channel.

C. Regularly merge duplicate contacts to keep tracking data accurately.

D. When using an external database of record, utilize that system's identifier as the contact key.

Correct Answer: B, D
Section:

QUESTION 131
Northern Trail Outfitters has several business units (BU) and each BU uses specific data extensions, like Product Information.
How Should they configure these data sources?

A. Share data extensions from the top-level BU.

B. Create a local copy of the product data in each BU.

C. Use the File Transfer Activity to import data into each BU.

D. Give users the Administrator Role so they can see all of the data.

Correct Answer: A
Section:

QUESTION 132
A customer wants to reports on 'Not Sent' contacts in Journey Builder.
Which method should be used?

A. Use the standard report 'Subscribers Not Sent to'.

B. Use an automation with Tracking Extract.

C. Create an Analytics Builder Discover report.

D. Query the _sent Data View for the contact's send status.

Correct Answer: B
Section:

QUESTION 133
Northern Trail Outfitters wants to send a welcome email to Contacts when a Contact record is added as a campaign Member to a 'Loyalty Member' Campaign in Sales Cloud.
Which method should they use to send the email from Marketing Cloud?

A. Create a scheduled Automation with a Query Activity and a Send Email Activity

B. Use Content Builder Send Flow to send the email to the Salesforce Campaign

C. Create a Journey with a Salesforce Campaign entry source and an Email Activity

D. Create a Journey with a Salesforce Data entry source and an Email Activity
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Correct Answer: C
Section:

QUESTION 134
Northern Trail Outfitters is expanding globally into 16 new countries and wants to start localizing their email content to speak to subscribers in their own language. They want to do this as efficiently as possible and are
anticipating growth into other locales in the near future.
Which two options could be recommended? (Choose 2 answers)

A. Leverage Content Builder to create email templates for each language and populate the templates via the UI.

B. Leverage enhanced dynamic content blocks within Content Builder to create language-specific emails.

C. Leverage personalization strings within the email template to pull in language-specific content.

D. Leverage AMPscript within an email template to lookup subscriber language and personalize the email based on the value.

Correct Answer: B, D
Section:

QUESTION 135
Northern Trail Outfitters wants to encourage customers who made a purchase on their website without leaving a review to come back and review their purchase. They want to use Journey Builder to automatically inject
contacts who meet these criteria into a Journey.
What product should be recommended?

A. Audience Studio

B. Web Analytics Connector

C. Data Studio

D. Google Analytics 360

Correct Answer: D
Section:

QUESTION 136
Northern Trail Outfitters (NTO) maintains a blog for key outdoor enthusiast influencers to use in sharing their experiences with NTO equipment and the outdoors. NTO also sends out a weekly email newsletter, and they want
to include links to the latest blog entries as part of the newsletter.
Which two solutions could pull in the RSS feed at the time of send?
Choose 2 answers

A. Dynamic Content

B. AMPscript

C. Personalization Strings

D. External Content

Correct Answer: C, D
Section:

QUESTION 137
A B2B customer notices they have a large number of subscribers marked as 'Held'. During troubleshooting, they realize these were soft bounces from overwhelming the email servers of many of the small companies with
which they do business.
What step(s) should the customer take to move those subscribers back to 'Active'?
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A. Extract subscribers who have a status of 'Held', then import subscribers as 'Active'.

B. Use Contact Builder to mass update all 'Held' subscribers to 'Active' status.

C. Subscribers with a status of 'Held' should be re-enabled by contacting support.

D. Use a SQL query to change all subscribers with a status of 'Held' to 'Active' in All Subscribers.

Correct Answer: A
Section:

QUESTION 138
Northern Trail Outfitters (NTO) wants to find ways to better drive return on investment and growth via their marketing sends. They plan to centralize their analytics data to allow for a more efficient analysis of this data across
all of their campaigns. NTO currently has Marketing Cloud, Sales Cloud, and a third-party warehouse service.
What product would help their use case?

A. Report Studio

B. Web Analytics Connector

C. Interaction Studio

D. Datorama

Correct Answer: D
Section:

QUESTION 139
A consultant explains how a sending domain differs from a customer's primary domain. The customer is evaluating their options around configuring their domain.
Which two questions should their IT team be asked?
Choose 2 answers

A. Can they provide access for Marketing Cloud to update the DNS records?

B. Does their company allow delegation of subdomains to third parties?

C. Will they be able to post Marketing Cloud-provided DNS files when self-hosting?

D. Are they able to modify their domain configuration's DNS entries?

Correct Answer: B, D
Section:

QUESTION 140
A customer wants to import the previous 10 years of customer purchase data in their Marketing Cloud account. Through discovery, it is determined there are over 200 million records they plan to upload via the REST API, and
this volume will continue to grow as the current purchase data is added.
Which two questions should be asked for further discovery?
Choose 2 answers

A. Does their License include support for REST APIs?

B. How many API calls are included in their License?

C. Does their License include the Large Data Extensions feature?

D. Why do they require 10 years of historical data in Marketing Cloud?

Correct Answer: B, D
Section:
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QUESTION 141
Northern Trail Outfitters (NTO) wants to send using the From Address of marketing@email.nto.com.
They will then automatically forward replies to customerservice@nto.com. NTO also wants to include an automatic reply to the customer's email address customer@exampie.com.
Which email address would appear as the From Address for the automatic reply to the customer?

A. customerservice@nto.com

B. reply@marketingcloud.com

C. customer@example.com

D. A marketing@email.nto.com

Correct Answer: B
Section:

QUESTION 142
A customer wants to create a mobile app that requires users to log in or register before accessing their dat a. Their source of truth is Sales Cloud which is connected to Marketing Cloud. Users who log in with existing
credentials will have their device associated with their ContactKey. Users who register with the mobile app will not have their devices associated with a ContactKey for up to 24 hours.
What consideration should a consultant provide to the customer?

A. All mobile app users will create additional Contacts in Marketing Cloud.

B. User device data is unavailable in Contact Builder for up to 24 hours.

C. Existing users will create additional Contacts in Marketing Cloud.

D. Newly registered users will create additional Contacts in Marketing Cloud.

Correct Answer: D
Section:

QUESTION 143
Northern Trail Outfitters has integrated their Marketing Cloud account with their Salesforce sandbox.
In what order should the steps be performed to refresh the sandbox in their integrated account?

A. Disconnect / Refresh / Reconnect / Authenticate / Synchronize

B. Refresh / Disconnect / Reconnect / Synchronize / Authenticate

C. Disconnect / Refresh / Reconnect / Synchronize / Authenticate

D. Refresh / Disconnect / Reconnect / Authenticate / Synchronize

Correct Answer: A
Section:

QUESTION 144
Northern Trail Outfitters wants to have a periodic, dynamic newsletter send to a set data extension, but the data in this data extension will be regularly updated and the subscribers inside could be removed/added multiple
times.
What option should speed up the delivery while meeting these criteria?

A. Journey that allows re-entry after exiting

B. Scheduled Automation utilizing Triggered Send Emails

C. Scheduled Automation using a Send Activity

D. Single Send Journey
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Correct Answer: C
Section:

QUESTION 145
Northern Trail Outfitters wants to send an email to website visitors who add items to their cart but fail to make a purchase. The email will include a list of products they added to their shopping cart.
• A sendable data extension contains the contact information and a session ID field for each subscriber who has abandoned their cart.
• A second data extension contains a corresponding session ID field and product data for each abandoned cart item, including product SKU, product name, quantity, price, and image URL.
Which feature should be used to display the list of products for each subscriber in this email?

A. Lookup AMPscript function

B. LookupRows AMPscript function

C. Dynamic Content Block

D. Enhanced Dynamic Content Block

Correct Answer: B
Section:

QUESTION 146
Northern Trail Outfitters is sending to an audience of over one million subscribers. They will use 10 different personalized fields in the email which reside in multiple data extensions. The goal is a timely email send from start
to finish as it contains a limited quantity, first come-first served, special offer.
How should they accomplish this task?

A. Create and populate profile attributes for each of the 10 data extension fields and schedule a send with high priority.

B. Enable Send Throttling on high to ensure the speed Is increased to process the email as fast as possible.

C. Use the Lookup AMPscript function in the email to pull the fields from the data extensions for each subscriber.

D. Create and send to a sendable data extension containing those needed fields using a query activity.

Correct Answer: C
Section:

QUESTION 147
Northern Trail Outfitters (NTO) wants to create a relevant audience from a data extension for a daily send campaign. The audience will change from day-to-day. These emails contain a View As Web Page link and NTO wants to
ensure this will not be broken when the audience is refreshed daily.
What should be used to segment this audience?

A. Use exclusion lists for the send - excluding those that already were sent the email

B. Use AMPscript inside the email to pull information from a send logging data extension to determine which content displays based on message context

C. Use a SQL Query to filter the audience into a new data extension that is overwritten each day

D. Use SQL Query to filter the audience into a new data extension that is upserted every day

Correct Answer: B
Section:

QUESTION 148
Northern Trail Outfitters noticed that clicks are NOT showing up on Contact records in Salesforce.
Which two reasons could be the cause?
Choose 2 answers
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A. Synchronized Data Sources only push data every 15 minutes

B. ContactID was used as Subscriber Key

C. Email Address was used as Subscriber Key

D. Individual Level Tracking was not selected in Marketing Cloud Configuration

Correct Answer: C, D
Section:

QUESTION 149
Northern Trail Outfitters is sending email messages using Marketing Cloud Connect through the Sales Cloud user interface. All of their sends initiated from Sales Cloud have a status of failed.
What should the consultant do to diagnose the issue?

A. Initiate a log to troubleshoot package-related API calls.

B. Change the connection option to Scope by User.

C. Ensure the System User is assigned the Standard User Profile.

D. Manually clear the OAuth token to refresh the connection.

Correct Answer: A
Section:

QUESTION 150
A real estate agency wants to send out a biweekly newsletter with the list of properties for all new contacts added to a newsletter campaign in their Salesforce CRM. The journey consists of an initial message with property
listings and a follow up to those who have engaged with the content.
The rules around which properties are matched to the contact depend on agent assigned as a contact owner, other agents who might have interacted with the contact, and contact's property interest. The data model has a
relationship between contact > person account > real estate agent > property objects and all of those are available in CRM as well as synchronized to Marketing Cloud.
What solution should be recommended for execution efficiency?

A. Use Automation Studio and Salesforce sends with campaign as an audience.

B. Use Automation Studio to prepare personalization data and initiate journey.

C. Use Salesforce Data Event to initiate journey and scripting within emails for personalization logic.

D. Use send from Salesforce CRM and Salesforce report to prepare personalization data.

Correct Answer: C
Section:

QUESTION 151
Northern Trail Outfitters has acquired a new company and is importing customer data to Marketing Cloud. They want to ensure commercial emails are not sent to email addresses who have previously opted-out.
Which feature should they use?

A. Exclusion Script

B. Auto-suppression List

C. Suppression List

D. Exclusion List

Correct Answer: B
Section:
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QUESTION 152
Northern Trail Outfitters (NTO) wants to implement an abandon cart journey. The data for the journey exists in three separate data extensions (DE).
• The first DE is populated by web analytics data, and does not contain a Subscriber Key or Email Address value.
• A Customer Reference DE is updated daily and holds subscriber information.
• The third DE is populated by a file sent to the SFTP after five days If the customer has not purchased the abandoned items.
• The third DE will be used in the journey for a decision split, and it does not contain a Subscriber Key or Email Address.
• If the web analytics file is empty, NTO does not want the automation to finish running.
Which order of activities should be used to fulfill this requirement?

A. Scheduled Automation > Import File Activity > Data Extension Entry > Query Activity for file one > Query Activity for file two

B. File Drop Automation > Import File Activity > Verification Activity > Query Activity for file one > Query Activity for file two > Data Extension Entry

C. File Drop Automation > Verification Activity > Query Activity for file one > Data Extension Entry > Query Activity for file two

D. Scheduled Automation > Import File Activity > Verification Activity > Data Extension Entry > Query Activity for file one > Query Activity for file two

Correct Answer: B
Section:

QUESTION 153
ABC Company wants to automate the sending of shipping notices and a customer survey.
• Shipping notices will be sent once a day.
• The shipping file will be placed on the FTP some time after 4:00 p.m.
• The shipping data will be sorted in the Shipping Notice data extension.
• A field in the data extension will contain the shipping date.
• The survey needs to be sent at 9:00 a.m., exactly 10 days after the customer's order ships.
Which workflow would most effectively enable ABC Company to do this?

A. Automation 1: Triggered Import File -> Filter -> Send Email -> Wait-> Filter -> Send Email

B. Automation 1: Scheduled to run daily at 7:00 PM Import File -> Filter -> Send Email -> Wait -> Filter-> Send Email

C. Automation 1: Scheduled to run daily at 7:00 PM Automation 2: Scheduled to run daily at 9:00 AM Import File -> Filter -> Send Email -> Filter -> Send Email

D. Automation 1: Triggered Automation 2: Scheduled to run daily at 9:00 AM Import File -> Filter -> Send Email -> Filter -> Send Email

Correct Answer: A
Section:
Explanation:
If a question is related to automation and it mentions that a file will be available in the FTP always at a specific time, your answer will be an option with a scheduled automation. Scheduled automations are used when you
know the time a file is pushed into FTP and it always runs at a scheduled time. If a question is related to automation and there is an uncertainty when the file will be pushed to FTP (ex; a day before last working day / if a date
falls on a weekend, it will be available on last Friday etc.), your answer will be an option with a Triggered Automation.
Triggered Automations are fired as soon as a file hits a specific location within FTP. Transfer activity is involved when file is encrypted.

QUESTION 154
Northern Trail Outfitters' marketing team is made up of a marketing manager, a marketing specialist, and a graphic designer. The team is new to Marketing Cloud and has very little coding experience.
Currently, they use Excel and VLOOKUP to segment their email audiences and import them into Marketing Cloud.
What solution should be recommended to allow for long-term self-sufficiency in segmentation?

A. Data Filters

B. Attribute Groups

C. Publication Lists

D. Query Activities
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Correct Answer: A
Section:

QUESTION 155
A customer has been having problems with SMS responses getting the default keyword response rather than the appropriate next keyword response.
What are two potential reasons for this unexpected response?
Choose 2 answers

A. Responses are not sent within 24 hours of the outbound message.

B. Response contained "stop" in the message content.

C. Responses are not sent within the Conversation Window.

D. Next keyword was not specified on the outbound message.

Correct Answer: A, D
Section:

QUESTION 156
Northern Trail Outfitters (NTO) imports a file daily into Marketing Cloud of customers who have bought a tent from their website that day. They want to set up a month-long welcome Journey which sends emails specific to
the purchase such as the type of tent, the available accessories for the tent, and care of the tent at different points throughout the Journey. NTO also recognizes that due to their competitive prices, they have had customers
purchase more than one tent within a month.
What type of data should be used in the Decision Splits in their Journey to make sure the choices reflect the correct tent?

A. Journey Data

B. Entry Data

C. Contact Data

D. Salesforce Data

Correct Answer: A
Section:

QUESTION 157
A customer has curated a list of known email addresses belonging to competitors. They want to ensure none of these competitors receive their emails.
What should a consultant recommend'

A. Create an auto-suppression list populated with subscriber keys.

B. Populate a list using a query to exclude the subscriber key.

C. Create an exclusion list with the known email addresses.

D. Create an auto-suppression list populated with the known email addresses.

Correct Answer: D
Section:

QUESTION 158
A customer indicates their point-of-sale system can be configured to upload a file every fifteen minutes. The filename is not consistent for each upload. Their consultant recommends they use a File Drop Automation.
Which two considerations should be made?
Choose 2 answers

A. They may utilize an external FTP site.
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B. The directory Is unable to be used by another File Drop Automation.

C. The directory used by the file trigger should be inside the import directory.

D. The directory cannot contain more than five file triggers.

Correct Answer: B, C
Section:

QUESTION 159
Northern Trail Outfitters wants to automate a weekly SMS message to be sent to anyone who has a birthday that week. They have created the Outbound Message in MobileConnect and have a Filtered List created for every
contact who provided birth date information.
Which activities would Marketing Cloud use to automate this campaign?

A. Refresh Mobile Filtered List and Outbound Send

B. Import Mobile Contacts and Outbound Send

C. Refresh Mobile Filtered List and Send SMS

D. Import Mobile Contacts and Send SMS

Correct Answer: C
Section:

QUESTION 160
Northern Trail Outfitters is growing and acquiring other organizations, each with its own instance of Sales Cloud. They are debating whether to upgrade Marketing Cloud Connect to Multi-Org.
What consideration could be provided to help with the decision?

A. Shared Salesforce Data Extensions will be enabled in up to 5 business units.

B. Custom profile and subscription centers will not be required.

C. Once an account is upgraded to Multi-Org, it cannot be turned off.

D. Existing accounts cannot be upgraded to Multi-Org.

Correct Answer: C
Section:

QUESTION 161
Northern Trail Outfitters is migrating from a legacy emailing tool to Marketing Cloud. As part of the migration, they have to go through a security review. Their data privacy team has made it clear that the data in the sandbox
should never be mixed with data In production during testing cycles.
What recommendation would a consultant provide on the architecture to fulfill this requirement?

A. Implement two separate Marketing Cloud instances.

B. Ensure test sends are done from data extensions with attribute 'Is Testing1.

C. Create one or more additional business units for testing.

D. Use Subscriber Filter per business unit to filter production from test data.

Correct Answer: A
Section:

QUESTION 162
Northern Trail Outfitters uses separate Marketing Cloud accounts as environments for development, UAT, and production. They want to test all automations and Journeys In each environment prior to launching in production.
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Which extension product should be used to speed up the migration of data extensions and Journey Builder configurations between each environment?

A. Configuration Manager

B. Change Sets

C. Deployment Manager

D. Ant Migration Tool

Correct Answer: C
Section:

QUESTION 163
A customer wants to integrate a new dataset with pre-existing contacts. This data will be updated via separate data feeds from the main contact information.
What data model configuration should be recommended'

A. Create additional attribute fields in the main contact data extension.

B. Create new Salesforce data extension and link it to the other data extensions.

C. Create a new data extension and link it to the other data extensions.

D. Create a new data extension and link It as a new population.

Correct Answer: C
Section:

QUESTION 164
Northern Trail Outfitters is investigating implementing MobileConnect to allow SMS messaging in their UK, Germany, and Swiss subsidiaries. Each subsidiary has its own business unit and they are trying to determine if a single
long code could be used for all markets.
What functionality would tie to additional long code Implementation?

A. Do they need to support UTF-8 characters in their SMS?

B. Do they need to support different From Names by country?

C. Do they need to have independent reporting on SMS sends by country?

D. Do they need to support inbound messages in each country?

Correct Answer: D
Section:

QUESTION 165
Northern Trail Outfitters wants to set up an automation that imports a file and sends an email to the contacts when the file is dropped on the SFTP. The name of the file will change, though it will always start with
thankyou_customers.
How would they set up the Import Activity to know the name of the file?

A. Set File Naming Pattern to %%AUTOMATED_FILENAME%%

B. Set File Naming Pattern to %%BASEFILENAME_FROM_TRIGGER%%

C. Filename is automatically passed to Import Activity with File Drop Automations

D. Check the 'Use filename from Automation' checkbox

Correct Answer: B
Section:
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QUESTION 166
Northern Trail Outfitters wants to connect relational data Into their Journey without overloading the entry data.
How should they connect the data?

A. Entry Source Data Extension

B. Contact Configuration

C. Data Designer

D. Data Relationships

Correct Answer: C
Section:

QUESTION 167
A customer asks why the send time values within an email are not being added to a Send Log.
Which two actions would successfully write send time variables to their Send Log? Choose 2 answers

A. Match an AMPscript variable name to a Send Log field.

B. Use the WriteToLogO AMPscript function In the content.

C. Ensure the send log Is linked In an attribute group.

D. Enable send logging to a data extension during send process.

Correct Answer: A, D
Section:

QUESTION 168
Northern Trail Outfitters is using a Salesforce entry event in a Journey to send SMS to contacts located in the United States. They notice new SMS contacts are not receiving messages, and the mobile number in the Salesforce
Entry Data Extension was missing the country code.
How could they resolve this issue?

A. Select 'Normalize Phone Number* in Journey settings.

B. Format the phone field in Salesforce as +l[phonenumber],

C. Select 'US' as the sending country in SMS activity.

D. Configure the phone field in Salesforce as US locale.

Correct Answer: B
Section:

QUESTION 169
Northern Trail Outfitters wants to include the body of marketing email replies captured by Reply Mail Management (RMM) within auto-forwarded messages to their Customer Success team.
How could they accomplish this?

A. Check the Include Replies as Attachments'' box in the RMM settings.

B. Use RMM dynamic content blocks to render the email reply body.

C. Query the RMM data view for the reply body and reference it from a data extension.

D. Use RMM personalization strings to render the email reply body.

Correct Answer: D
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Section:

QUESTION 170
Northern Trail Outfitters is interested in a solution to automate a process. They currently pull data into a spreadsheet to import into a data extension for sending. The data warehouse can be configured to place a dally on an
SFTP.
Which three questions are relevant to determining a solution?
Choose 3 answers

A. Does the data extension have a data relationship?

B. Does someone need to be notified if an error happens on import?

C. Will the data file be placed on the SFTP at the same time daily?

D. Will the file have more than 5,000 rows?

E. Is the data file a delta or a historical file?

Correct Answer: B, C, E
Section:

QUESTION 171
A customer wants to create a loyalty program by Identifying all subscribers who clicked on a link within any email sent within the last six months.
What should be recommended?

A. Create and execute a SQL Query against the _Click data view.

B. Create and execute a Tracking Extract.

C. Create and execute a Subscriber Engagement report.

D. Create and execute a Data Filter on the_Click data view.

Correct Answer: A
Section:

QUESTION 172
Northern Trail Outfitters wants to suppress their highly engaged email subscribers (multiple opens and clicks for a target campaign) from active display campaigns to reduce overall cost and eliminate unnecessary targeting to
the user.
What should be recommended?

A. Mobile Studio

B. Advertising Studio

C. Google Analytics 360

D. Einstein Engagement Scoring

Correct Answer: D
Section:

QUESTION 173
Northern Trail Outfitters has created child business units (BU) for their different regional offices. They want to limit subscriber records by BU, so users who are assigned to a BU can only view and send to Subscriber records in
their region. A Profile Attribute named 'Region' associates a subscriber to a geographical region.
How could they ensure subscribers with a matching 'Region' Profile Attribute value are available in each BU?
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A. Create a list in each BU and add subscribers with a matching Region to the list.

B. Create a measure for each corresponding 'Region' Profile Attribute and include the measure in a Filtered Data Extension for each BU.

C. Open the the Profile Attribute Properties for the Region' Profile Attribute and select the 'Filter Subscribers by Attribute' option.

D. Select 'Define Subscriber Filter' for each BU on the BU Setup page and configure a condition to match the corresponding Profile Attribute.

Correct Answer: D
Section:

QUESTION 174
Northern Trail Outfitters has a file that drops intermittently to their SFTP account. Once this file drops, they want to be able to have it immediately imported and then segmented to enter a specific journey depending on the
data inside the file.
Which two options would meet these requirements?
Choose 2 answers

A. Scheduled Automation

B. File Drop Automation

C. SQL Query

D. Decision Split

Correct Answer: B, C
Section:

QUESTION 175
Northern Trail Outfitters sends emails for Password Resets from their web store when requested. An SMS message should be deployed if the password reset email is not sent.
What processes should they utilize to ensure a timely delivery across email and SMS?

A. Triggered send definition and use data extract Not Sent to a data extension then send SMS to those failed sends

B. Multiple path journey with engagement split if password reset link clicked; if link not clicked, then SMS Password Reset activity

C. Triggered send definition, and use API response to determine and send API call to trigger an SMS password reset

D. Transactional email send with the event notification service response to determine and trigger an API call to an SMS message

Correct Answer: D
Section:

QUESTION 176
Northern Trail Outfitters (NTO) is creating a birthday journey and one of the requirements is to divert anyone who has redeemed the promotional code before reminder emails are sent on the 15th and 20th of each month.
Their transactional information, which includes redeemed promo codes, Is housed in a separate data extension than the one used for Journey injection. NTO needs to use an attribute to attribute comparison on the customer
number field in the Journey source and transaction data extensions.
Which activity would they use to accomplish this?

A. Decision Split Activity using only Contact Data

B. Decision Split Activity using only Journey Data

C. Einstein Split Activity

D. Decision Split Activity using both Contact and Journey Data

Correct Answer: D
Section:
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QUESTION 177
A customer is connecting Sales Cloud with Marketing Cloud. The connection was successful, however, the team is unable to view or sync Sales Cloud objects in Contact Builder.
How should a consultant begin troubleshooting the connection?

A. Create and send an email in Email Studio to test the connection and validate tracking.

B. Validate Marketing Cloud and Sales Cloud users have access to the business unit.

C. Create new Marketing Cloud and Sales Cloud users and perform a new installation.

D. Validate Marketing Cloud and Sales Cloud permissions for the connecting users.

Correct Answer: D
Section:

QUESTION 178
Northern Trail Outfitters has a data extension that stores all of their orders. They want to send out a dally email for orders with their status changed to 'shipped' that day through a journey.
Which two methods should be used to filter entry into the journey?
Choose 2 answers

A. Filter Activity

B. Entry Source Filter

C. SQL Query

D. Decision Split

Correct Answer: B, C
Section:

QUESTION 179
A customer wants to use Sales Cloud as a system of record for email messages sent from Marketing Cloud; however, the customer only sends from custom objects and cannot use the Contact ID or Lead ID as the Contact Key
in Marketing
Cloud.
What is the implication of this data model when using Marketing Cloud Connect?

A. Email Sends will fail if the Contact ID or Lead ID is not included.

B. Tracking Data will not be returned to the Sales Cloud email recipient.

C. The customer will be able to use Reports and Campaigns as audiences.

D. The customer will be unable to use synchronized data extensions.

Correct Answer: A
Section:
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